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Before, During & After Directions for Video Taping 

In addition to the guidelines below, check out these video tips from the 
University of Wisconsin-Platteville: https://www.youtube.com/watch?v=a9ypx8DJq2U. 

Introduction 

These procedures are provided to help you produce video clips that 
clearly represent the teaching and learning in your classroom.  In order 
to capture elements of instruction and student learning, you will need to 
produce video clips of high audio and video quality.  To facilitate video 
conversion, make sure your video camera is digital and can connect via 
firewire or USB (no disks). Use standard, not high definition. 

Preparation and Practice 

First, we do NOT expect a Hollywood production.  It is important, however, that the 

quality of the videotaped activities be sufficient for scorers to understand what happened 

in your classroom.  As a general rule of thumb, sound quality is generally more important 

than video quality to understanding the teaching and learning being captured. 

 If you are unfamiliar with the videotaping process and/or do not have access to video 

equipment, consider the following resources for equipment and videotaping 

assistance: 

 your cooperating/master teacher (who can identify potential resources in the 

school as well as assist you with videotaping); 

 your university supervisor; 

 Technology staff within your program’s institution who are knowledgeable about 

videotaping; 

 another student teacher who has done or is doing videotaping; or 

 friends and family (for equipment). 

 Bilingual blocks have access to cameras & tripods (plus a limited # of 

microphones) that can be checked out from the LARC (Language Acquisition 

Resource Center) Lab in Storm Hall 204 or 205: http://larclab.sdsu.edu/about/.  

Time is limited to 5-10 days. Do not transfer camera to anyone else without filling 

out paperwork. Return promptly (before 10 days if possible) so others can use 

them.  

 You can also rent digital video cameras (make sure they have firewire ports or can 

connect via USB) from 

 

Audio and Video Camcorder Rental  

5201 Linda Vista Rd, Suite 101 / San Diego, CA 92110  

 

https://www.youtube.com/watch?v=a9ypx8DJq2U
http://larclab.sdsu.edu/about/
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Time Zone Multimedia   http://timezonevideo.com/newsite/video.php  

4585 Murphy Canyon Rd. / San Diego, CA 92123  

(858)569-4000  

Cost:  About $25.00 Camera Rental. About $5.00 Tripod Rental.  

??? microphone rental. Camera and tripod w/ tax, about $35 (prices may be out of date) 

 

 Arrange for the necessary video/audio equipment well in advance (some places will 

let you reserve, others are first come, first served) and return promptly – others may be 

waiting for it.  

 Include a sturdy tripod to avoid shaking images which often stem from shots from a 

hand-held camera. 

 

BEFORE 
 

1. Advise your cooperating/master teacher and the principal at your school of your 

need to videotape lessons for your Teaching Event and provide a copy of anything 

you send to parents. 

2. Send out & collect parent/guardian permission slips for video. Candy or points can 

encourage return of slips. Follow up w/phone reminders as needed. 

3. Once you have the camera, check if it uses a mini-digital tape. Buy your own tape, if 

so. (Take the camera to the store with you.) 

4. Plug it in to charge the night before. 

5. If someone is helping you, Share your lesson plan and discuss your plans to capture 

the teaching and learning.  have them (a) practice setting the camera up and (b) make 

a test run in the classroom. If you are taping yourself, then do this yourself. 

6. Check the field of view so you know where to seat students in or out of view 

depending on whether they have permission to be video taped.  

 Think about where you and your students will be during the activities to be portrayed 

on the videotape.  Will different activities require students to regroup and move 

around the classroom?  How will the use of instructional materials be recorded?  

What will the camera need to capture?  If applicable, when should the camera 

operator zoom in or rotate the camera to a new position? 

 

 Practice the videotaping process.  This will provide a chance to test the equipment 

and give your students an opportunity to grow accustomed to the camera. 
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DURING 
 

1. During filming, make sure that only students with permission are in view.  

 

2. For safety reasons, tape extension cords to the floor with duct tape. 

 

3. Have someone check that the camera is recording both audio & video. 

 

4. Keep a record of attendance that day & mark off who did or did not grant permission 

for video taping. 

 

 Adjust, if necessary, for the light source each time a recording is made.  Newer 

cameras may have a switch for recording in incandescent, florescent, or daylight or may 

be completely automatic.  Do not place the camera facing the window or other bright 

sources of light. 

 

 If the camera operator wears headphones plugged into the camera, the sound quality 

can be monitored during taping. Otherwise, check afterwards. If you and/or the students 

are difficult to hear, try placing the camera closer to the action next time OR use an 

external omni-directional dynamic microphone plugged into the “EXT MIC” jack on the 

camera.  Confirm that this turns the internal microphone off.   

 

 During videotaping, don’t worry about calling students by name, or having them 

address you by name.  Note that names or other identifying information heard on the 

videotape will remain confidential to the scorers. 

 

*Never leave the camera anywhere unsecured! 

 
AFTER 
 

1. Right after filming, view the tape to make sure it recorded both 
audio & video.  

a. Either right afterward or within 1 day, review the tape & 
pick the clip(s) you wish to submit for your video project 
first semester or with your Teaching Event (TE) second 
semester.  

b. edTPA: Read over Task 2: Instruction and review rubrics 6-
9 (5-8 for World Languages). Taken all together, your clip/s 
should demonstrate the targeted competencies. 
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2. Mark the starting and ending points (minutes) of your selected 
clip(s) on a sticky note for easy reference. Keep this with the tape! 

3. If the sound is poor, write down what is being said in the relevant 
clip(s). This will also allow you to easily refer back to it when you 
are reflecting. 

*Do not leave the camera visible in your car.  
 
SAVING & SUBMITTING 

1. Guided practice with video conversion set up by block. 

2. Bilingual Blocks can use Independent lab time in LARC approx. M-
Th 8am-8pm: http://larclab.sdsu.edu/about/. 

3. Instructions on video conversion on Blackboard site. 

4. Once converted and uploaded – be sure to delete the original 
material before returning the camera. This protects the privacy of 
both you and your students. 

* Please bring (1) your tapes with the clips pre-selected, and (2) the 
camera you used.  
 

http://larclab.sdsu.edu/about/
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Pictorial Directions for Using 
Tripods
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Tip: You can set the camera up and leave it in place (it is OK if you are sometimes out 
of the frame as long as you and the students can be clearly heard). Alternatively,  ask 
another student teacher to run the camera for you as you teach (make sure that person 
has official permission to be on campus). Your peer can use the tripod handle to turn the 
camera toward important elements in the classroom during the lesson. Later you can run 
the camera for those who helped you. Avoid following the subject around with the 
camera or zooming in and out.  These tactics create a jerky image that may make 
viewers dizzy. Use the tripod arm & leave the camera stationary as much as possible. 

Charging the Camera (recharge before taping!) 
Make sure the camera is fully charged. Flip cameras and similar small video cameras 
can charge if they are plugged into the computer. Regular cameras must be plugged into 
the wall. Test it before using, as old cameras won’t always hold a charge. If your camera 
is not holding a charge, find a new one.  

Inserting a digital or mini-digital tape (for older digital video cameras) 

Tip: Buy your own tape so you can keep it afterwards.  Once your grade posts &/or you 
pass the edTPA, destroy the original in order to preserve the privacy of those on screen. 
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Just Before you Begin Taping 

*Again, keep the power off until you are ready to tape.  This will save the battery. 
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Place the camera in a position where you are in view as you teach. Make sure only students 

for whom you have permission slips are within view of the camera. You do not need to 

capture images of all the students. If you have another student teacher run the camera for you 

as you teach, your peer can use the tripod handle occasionally to turn the camera slowly 

toward important elements in the classroom during the lesson. You might even run a 15-

second sound test to make sure the camera is picking up your voice; if not, move the camera 

closer to you. Know that when you view the tape on television, your voice will be clearer and 

louder.  

 

Find the little green power button. Press the power button down as you rotate the mechanism 

to the left.  

The viewfinder should say tape mode. If not, slide the tape/card switch to tape (see Before 

You Begin).  

 
 

Videotaping Your Lessons  

Most candidates will be selecting two 5-10 minute clips to include as evidence of instruction. 

Look at your handbook and follow the specific guidelines provided. (Some content areas 

require more or fewer clips.) Be strategic about what you  tape so that the video shows  

 

(1) All students actively engaged with the material e.g. via think pair share or quick 

write or other strategies for mass engagement,  

(2) The teacher asking higher order thinking questions & follow-up questions (follow 

up questions are redirected to the same student to get him/her to think more deeply) 

to monitor understanding & progress toward  the objective. 

 

Check your tape and sound quality immediately afterwards. If  you can’t hear students, create 

a transcript of what they said. Tape on at least two separate days so that you have some 

choice and also a backup in case one does not work or students are acting up. Tape takes a 

long time to review so don’t just tape everything, be strategic in your choices (see above).
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When the camera is turned on, the green pause icon will appear in the viewfinder.  

You will also see an image of your room.  
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Play back the tape on your TV or Computer to check the sound & video. 

 

Playing Your Videotape  
Since sound is the most essential element, we suggest that you playback the videotape 

through your television set or computer so you can assess the sound as you select your video 

clip/s (see handbook for guidelines on clips). Below are directions for TV.  See instruction 

manual for directions for high definition TV and Video processing directions for Computer.  

Before you turn on the power, familiarize yourself with the playback modes on the 

viewfinder.  
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Review your Tape & select the clip  

As you review, think of the clips you might want to use. Take notes on how the students 

are engaged (what they are doing), the questions you are asking, and whether you are 

redirecting any questions to prompt deeper thinking. Be sure to note the starting point of 

each of the clips. For example, 00:03:42:17 would mean the first segment would start at 

zero hours, 3 minutes, 42 seconds, and 17 frames. After selecting your clips, rewind the 

tape to the beginning of the first clip (for example to 00:03:42:17). Doing so will make 

your uploading, processing and converting run more smoothly.   

Keep your video and the notes on the starting points for your video clip/s together in a safe place. 

Bring both to the university when you attend the processing & converting session. 
 

– Directions specific to the edTPA  Teaching Event (current as of 2014) 
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Video Processing 

Info: Video Tech Specifications 

TaskStream accepts most video formats* but you will need to pre-select the clip. 

Anything over 10 minutes will probably need to be converted into a smaller size. We 

recommend that those who convert videos save them as .mov, .wmv, .mpeg, H.264 or 

mp4 format.  If your clip is over 10 min, you will probably need to use special settings 

(in iMovie, click on use or options & select medium streaming) to reduce the size to 

under 500MB (300MB is a good target size but you can go up to 500 if needed). See the 

directions for details. Remember, this isn't a film competition and the smaller the file, the 

faster it will load.  

*iPad or phone video – transfer to a computer first & upload to TaskStream from the 

computer. 

NOTE: In addition to the 500MB file size limit, there is a 2,000 MB limit for the entire 

content of data uploaded to a basic TaskStream account. If you exceed this limit, notify 

your coordinator and TaskStream  (TS). 

 

When editing your video clip, it is usually easiest to use the free software that comes with 

your computer. PC's have the program Windows Movie Maker (found in the START 

menu under PROGRAMS) while Macs provide you with iMovie. You can also go to the 

LARC Lab and use Adobe Premier. There are many online tutorials that will support you 

in learning how to use these programs: 

 

Tutorial for using Windows Movie Maker to edit your video 

http://windows.microsoft.com/en-US/windows-vista/Getting-started-with-Windows-

Movie-Maker 

 

Tutorial for using IMovie to edit your video 

http://desktopvideo.about.com/od/imovievideotutorials/iMovie_Video_Tutorials_Learn_

How_to_Use_iMovie_From_Video_Tutorials.htm 

 

Tutorials for using Adobe Premier to edit your video   

Edit - http://evscicats.com/blog/introduction-to-adobe-premiere-pro/ (Select Standard 

Definition, not High Definition, or it will be too large.) 
 

http://windows.microsoft.com/en-US/windows-vista/Getting-started-with-Windows-Movie-Maker
http://windows.microsoft.com/en-US/windows-vista/Getting-started-with-Windows-Movie-Maker
http://desktopvideo.about.com/od/imovievideotutorials/iMovie_Video_Tutorials_Learn_How_to_Use_iMovie_From_Video_Tutorials.htm
http://desktopvideo.about.com/od/imovievideotutorials/iMovie_Video_Tutorials_Learn_How_to_Use_iMovie_From_Video_Tutorials.htm
http://evscicats.com/blog/introduction-to-adobe-premiere-pro/
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Convert - http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-

adobe-media-encoder/  We recommend .mov (Quicktime), .wmv (Windows Media), H.264, .mp4 

or .mpeg format but see specifications in the edTPA appendix for acceptable alternatives. 
 

 

Supported formats for uploading to Windows Movie Maker:  

 

Video files:  .asf,   .avi,  .wmv 

Movie files:  .MPEG1,  .mpeg,  .mpg,   .m1v,   .mp2 

 

Supported formats for uploading to iMovie:   

 most DV,  .Jpeg, .Mpeg   .mp4  

iMovie is iffy on .avi and .mov formats (although it will convert to .mov).  

* iMovie won't accept .wmv files.  

 

You can sometimes avoid format issues by bringing in the video camera and 

downloading the clip directly to the computer (via a firewire connector or USB). 

 

 
Source: https://www.edtpa.com/Content/Docs/RecommendedVideoFormatsandSettings.pdf  

 

TIP when playing back the video at home: Whether a video plays can depend on what 

software you have on your computer. Downloading the free VLC Media Player will let 

you play most videos: http://www.videolan.org/vlc/ . 

http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-adobe-media-encoder/
http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-adobe-media-encoder/
https://www.edtpa.com/Content/Docs/RecommendedVideoFormatsandSettings.pdf
http://www.videolan.org/vlc/
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Flow Chart for Video Processing – match camera with directions  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

© 2011 Created by Amanda Howard; modified 11/2012, T C-P. 

What to use to process video(depending on type of computer) 

 

 

 

 

 

What kind of 
camera do 
you have? 

Digital Video: 

Ex. regular Sony or 
Cannon Digital Video 
with cassettes. 

Old fashioned 
Video Camera 

(not digital) 
without ports 
OR digital 
with mini 
C.D.s 

Flip Camera or other 
small unit 

DO NOT 
USE!!!  

Yes, use 
the Flip 
camera 
instruction 
sheet.  

No, I have 
the file on a 
USB Drive. 

Do you 
have it 
with 
you? 

Use the 
directions on 
loading from a 
file.  

Use 
traditional 
instructions. 

What type of 
computer are you 
using? 
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Apple or Mac: Use 
iMovie directions. 

*If it is in LARC, see 
secure log-on 
directions below. 

No video 
processing 
software?  

PC: Use 
Windows 
Movie  Maker 
directions. 

For PC, try  downloading the free AVS 
Video editor: 
http://www.avs4you.com/AVS-
Video-Editor.aspx. We do not have 
directions but check on-line for help. 

There is nothing free I 
would recommend for 
Apple or Mac.  Instead 
use a lab on campus. 

http://www.avs4you.com/AVS-Video-Editor.aspx
http://www.avs4you.com/AVS-Video-Editor.aspx
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Step 1: Connecting your Video Camera & uploading to the Computer: 

Traditional Digital Video Instructions (e.g. regular size Sony or Canon 
video camera) 

1. Make sure that your camera is digital video and has a firewire port. If not, 

you shouldn’t have used it. Re-tape with another camera. 

2. Rewind the tape in the camera. Locate your preselected clips. If you can avoid it, 

do not load the whole movie. It is too big & it will take forever.  Only load the 

clips you plan to use. 

3. Plug in a firewire cable (Not a USB cable) between the camera and the Mac 

laptop/desktop.  The ports on the computer are on the back & labeled the 

following symbol: . The cable connector on the camera is often hidden 

beneath a small rubber cover. In some cases the camera port has a symbol, in 

others it is labeled as DV (digital video) in/out.  

Trouble shooting: If the computer sockets do not fit your firewire cable, you may be 

trying to use a 400 cable on an 800 port (or visa versa). Try either plugging in or 

unplugging the converter.  If you don’t have a converter and you are working with a 

newer MAC, check out a converter from LARC or the PLC office. 

Flip or other small video camera instructions 

 

1. Turn the camera on.  (You may need to hold down the “on button.”) 

2. Slide the USB latch to allow the USB arm to flip out. (You may need to pull back 

a rubber cover to see it.) 

3. Connect the camera’s USB arm to the computer’s USB port.  (If the camera gets 

in the way, use a USB extension – there may be one in the camera 

box.)
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Info: Compressing Video for TaskStream 

TaskStream allows users to upload videos up to 500 megabytes in size. If your video is 

10 minutes or less, you will probably not need to compress it. If it is longer, you will 

need to compress the video to make sure it is smaller than 500 megabytes in size.  

Below is a list of issues that may prevent you from uploading your videos on to 

TaskStream: 

 

 Videos over 500 megabytes in size 

 DVD video.  DVD video is usually much larger in size and cannot be uploaded 

directly into TaskStream using conventional means.  The DVD must be 

transcoded into a compatible digital video file, such as .wmv, .mov., or mpg. 

 Upload size restrictions from your Internet Service Provider (ISP).  For more 

information on your upload size restrictions, please contact your ISP. 

If your video is larger than 500 MB in size, you will need to compress (make smaller) 

your video to ensure that you can successfully upload your video to TaskStream.  Video 

editing software comes free with most PC and Mac computers.  If you want to use Adobe 

Premiere, it is offered at the LARC lab computer at Storm Hall 204/5.  Lab assistants are 

there to help you if needed. 

What if I don’t have video editing software? 
If you don’t not have video editing software on your computer and are not able to use the 

computers in the LARC lab, here are two extra options. If you already have your clip 

selected & do not need to edit it, you can download free compression and conversion 

software:  

 
 For PC: http://www.any-video-

converter.com/products/for_video_free/  
 For MAC: https://itunes.apple.com/us/app/any-video-converter-

lite/id479472944   

   

 

Directions for processing your video in iMovie, Windows Movie Maker or Adobe 

Premier follow. 

http://www.any-video-converter.com/products/for_video_free/
http://www.any-video-converter.com/products/for_video_free/
https://itunes.apple.com/us/app/any-video-converter-lite/id479472944
https://itunes.apple.com/us/app/any-video-converter-lite/id479472944


 © edited by T.  Collins-Parks from various sources. Last updated 11/06/2016   p. 20 

How to trim and compress video using iMove (on an Apple or Mac) 
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(Be careful to retain the file extension when renaming and saving your 

file.  If you accidentally delete it, you won’t be able to play the video.) 

 

Extra Tips for the edTPA Teaching Event 

 

Getting the right length for your clip: See your Teaching Event 

handbook for the maximum length allowed in your content area.  If you 

need to shave off time: Cut from the front or end of the clip ONLY. 

(Exception – you can remove the middle to create two clips.) Click and 

drag around it with your mouse so a yellow box appears over the portion 

you wish to delete.  Then press delete.  

 

 

 

 

 

Once you have your video clip, go to the directions for uploading to 
TaskStream. 
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How to Trim and Compress Video 

using Windows Movie Maker (on 

a PC) 

 

1.  First open up Windows Movie 

Maker from the programs menu.  

 

2.  Click the Add videos and 

photos icon.  Then choose the 

video file you want to compress.  

 

 

 

3. Your clip will show up on the right with a preview window on the left. 
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4. To trim the video, click on the edit tab.  Click and drag the black bar to the point where 

you want the clip to start and select “Set start point.”  Then click and drag the black bar to 

the point where you want the clip to end and select “Set end point.” 

 

 

 

1. Once you have the clip that you want to 

upload to TaskStream go to the Home tab 

and select Save Movie.    

2. If you have over 10 minutes of video, 

create a custom setting in order to make 

the file under 500 mb.  Otherwise skip to 

step 9. 

 

Drag the black bar to 
the start point. 
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3. Set the width to 320 and the height to 240.  You can set the bit rate as low as 

needed to make the file small enough.  The estimated file size per minute is at the 

bottom, use this to determine how low to set the bit rate.  A bit rate of 100 should 

guarantee that it will be small enough.  Click save to save the new settings. 

 

 

 

 

This gives you an 
estimate of how 
large your clip 
will be. 
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7. Give the settings a name such as TaskStream and save the setting. You can then close 

the custom setting dialog box.   
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8. Click on Save movie again and select your custom setting. 

 

Click here to use 
new setting. 
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9. A new window will appear.  Name your movie with the clip, lesson, subject, date and 

format (see extra notes on naming your file for an example), then select where you want 

to save it to on your computer. 

 

10. Choose where you will save your movie and click Save. 

 

 

 

Trouble shooting – if you misplace your video file, use the Finder to locate it. 

 

 

You can now close Movie Maker and open TaskStream to upload the video.  Go to Next 
Step -- UPLOADING TO TASKSTREAM: for directions. 



 © edited by T.  Collins-Parks from various sources. Last updated 11/06/2016   p. 28 

How to Trim and Compress Video using a Adobe Premier (on PC) 

Introductory tutorial to Adobe Premiere: 

https://www.youtube.com/watch?v=wK3JTh2jOf8&list=WL&index=5 
 

Edit - http://evscicats.com/blog/introduction-to-adobe-premiere-pro/ (Select Standard 

Definition, not High Definition, or it will be too large.) 
 

Convert - http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-

adobe-media-encoder/ (We recommend .mov or .wmv format.) 

Steps to follow 

1. First open up Adobe Premier from the programs menu.  

2. Click on new project, then okay. 

3. Go to “File” in the toolbar across the top and click on import.  Go to the location of 

your video file and double-click on that file. 

 

4. Now that you have your clip, you are going to convert it. Go to File and select Export 

from the drop down list.  Once the pop-up list appears, click on Media. 

http://evscicats.com/blog/introduction-to-adobe-premiere-pro/
http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-adobe-media-encoder/
http://evscicats.com/blog/convert-a-video-file-to-a-different-format-using-adobe-media-encoder/
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5. Slide the little white triangles at the bottom to trim the video (See box 5, below.) 

 

6. Your file must be under 500 mb.  (You can see the estimated file size in box 6a).  

To reduce the size, unlink the width and height under “Basic video settings” by 

clicking on the link icon – right next to the 6. in the screenshot above.  Then set 

the width to 320 and the height to 240.  Another option is to change the file 

format / encoding (see step 7).  The final option is to change the Preset.  Follow 

step 7 to change format to H.264 and then click the “Preset” field below Format to 

change to “Match Source – Medium Bitrate”  (the preset field is found just below 

box 7 in the screenshot above). 
 

7. To change the format, click on the triangle adjacent to “Format” in the top right. 

You will see a drop down list of options -- 7. in the screenshot above -- then click 

on the option you want to select. Some easily accessed file types are .mov 

(Quicktime), .wmv (Windows Media/Windows Movie Maker), H.264 or mp4.  

However, TaskStream also accepts flv, asf, qt, mpg, mpeg, avi, and m4v.  
 

8. Click export and the file will be saved in the same folder you imported it from. 

Trouble shooting – if you misplace your video file, use the Finder to locate it. 

You can now close Adobe Premier and open TaskStream to upload the video.  Go to 

Next Step -- UPLOADING TO TASKSTREAM: for directions.. . . .  

6a. 
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Adding Subtitles or Captions 
 

As of 2015, candidates can add subtitles or captions to clarify what is being said. This 

may be necessary if the sound is bad or if students are using a language that may not be 

understood by the scorer. If candidates do not want to use subtitles, they may include up 

to two pages of transcripts after their Task 2 commentary instead.  

 

Tip: Use subtitles or transcripts only for key interactions.  You do not need to subtitle nor 

do you need to translate the entire clip. 

 

Links to iMovie Directions for Adding Subtitles 

 

Here are some basic links for adding subtitles in iMovie: 

 Very brief and simple video on adding captions using the title 

function: https://www.youtube.com/watch?v=MpL_Capu15c. 

 5 step written directions on adding captions using the text tool in 

iMovie: http://classroom.synonym.com/add-subtitles-imovie-9524.html  

 Directions with pictures for iMovie 8 & 10: http://www.adoreshare.com/imovie-

converter/imovie-tutorials-on-how-to-add-subtitles-in-imovie-11-10-09-08.html 

Adobe Premier Directions for Adding Subtitles  

TIP: Before you start, put all of your media files in one folder on the desktop and save the 

Adobe Premiere project file there as well.  This will give you easier access. 

1)  Open up a new project in Adobe Premiere. (If Premier isn’t open, do a search in 

Windows for the desktop program.) 

2)  Import your media clip (will appear in bottom left window) 

Tip: Check the height and width settings and write them down.  Your Captions file will 

need to have the same settings. (To check settings, right click on the file and then select 

Properties from the pop up window.) 

3) Create a new sequence by right clicking on media file and choosing ‘new sequence 

from clip’ 

4) Go to File/New/Captions (On the toolbar across the top, click on File. From the 

dropdown menu, select New.  From the pop-up window, select Captions.) 

a) You will see a new pop-up window in the middle with settings. Make sure video 

settings for your Captions match the video settings for the media file. Click OK. 

b) Set at CEA 608/ CC1 (this is usually the default). Click OK. 

https://www.youtube.com/watch?v=MpL_Capu15c
http://classroom.synonym.com/add-subtitles-imovie-9524.html
http://www.adoreshare.com/imovie-converter/imovie-tutorials-on-how-to-add-subtitles-in-imovie-11-10-09-08.html
http://www.adoreshare.com/imovie-converter/imovie-tutorials-on-how-to-add-subtitles-in-imovie-11-10-09-08.html
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c) Go to Top Right Window/ Settings (wrench icon) and, select “Captions Display” 

from the pop-up menu and then click “Enable” on the additional pop-up window.  

Then click “Settings” and make sure they are the same (CEA 608/ CC1). 
 

6) At the bottom of the top right window, click on the plus sign, go to the closed 

captioning display button (a speech balloon icon), and drag it to the series of buttons at 

the bottom of the window, and then click OK. 
 

7)  You should see a regular video and a captions file in the bottom left box. Depending 

on the version you are using, 

and the directions you are 

following you may need to  

 

(a) Switch back and forth 

between the two. Click 

on the video file to hear 

the audio.  Click on the 

Captions file to enter 

captions.  

(b) Alternatively, if you 

double click on the captions file, you may get a screen such as the one in the 

screenshot here (exact configuration of boxes may vary) that allows you to go back 

and forth between captions and video more easily.  

(c) Lastly, the captions sometimes display in a 3rd column to the right (click captions in 

the menu displayed in the 3rd column).  
 

Tip: Transcribe the video first (with time stamps) so you can enter the captions without 

having to go back and forth. 

 

Troubleshooting: If you cannot see the captions window, select “Window” from the 

toolbar across the top then click “Captions” on the drop down menu. You can drag the 

edge of the captions window to enlarge it. 

 

8) To enter captions, once you have clicked on the captions file, you will see a black 

captions screen in one of the windows. Click on the plus icon in the corner to add a 

caption. (You may need to click the plus icon twice to both enter the previous caption and 

start a new caption.) Adjust the time in or out as needed to match the voice and video.   

 

Tip: Hit return after every 5 words or so – otherwise the rest of the line will be cut off. 

Keep each caption short (4 lines max). 

 

Troubleshooting:  Make sure your time in and out is sequential. DO NOT skip time.  The 

program will crash.  If you have some silence, enter the caption “[silence]” as can be seen 

at the top of the captions transcript below. You can also insert music notes (before and 

after the sound) and describe ambient sounds such as “footsteps” or “background 

conversations”. 
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9)  Adjust -- Set the in/out points, type in dialogue box.  Set the background color and 

text color.  Add lines if necessary. 

 

Troubleshooting: If the program does crash, the Adobe Premier auto-save function 

ensures that you’ll still have most of your work. Just go to the finder and look up the file 

“Adobe Premiere Pro Auto-Save”.  Inside you will find time-stamped versions of your 

project.  Open the latest file and keep going.  

 

10) To play your 

video with 

captions, click on 

a track on the 

playback screen 

(I clicked on V3) 

and drag the 

captions file 

over. Your 

playback screen 

should look like 

this.  Play the 

combined file in 

the upper box 

(not pictured here) to check that your captions are working correctly. 

 

(11) When done, go to File/Export/Media. (Click on “File” in the toolbar across the top, 

and select “Export” from the dropdown menu and then choose “Media.” )  From the 

export media screen, select Quicktime (.mov), Windows Media (.wmv)H.264 or mp4 as 
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the format (whichever works).  Choose the right preset so that the total size meets the 

requirements but gives you maximum quality. (Total size is shown at the bottom.)   
 

12) If you want to change the name and location, click “Output Name” to go to a pop-up 

screen where you can choose the new name and location of your file. Click “Save” to 

return. 
 

13)  From the same export media screen, select “Captions” from the toolbar across the 

middle to see the captions screen.  Under “Export Options”,  click the down triangle to 

see the choices and select “Burn Captions Into Video.”  
 

Original Screen where you select the format (see instructions #10). 

 
 
 
 
 
 

 
 

 
14)  Click “Export.” (Unless you changed the name and location, the File will be saved 

with the same name and location as the original.)  Exporting can take anywhere from 2-5 

times as long as the length of the original clip.  

 

 Select “Captions” from 
the Middle Tool Bar 

Click on the 

down arrow 

and select “Burn 

Captions Into 

Video.” 

Click “Output Name” to go 
to a pop-up screen where 
you can choose the new 
name and location of your 
file. Click “Save” to return. 
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Tip: When opening in Quicktime Player (or other media player), make sure that 

captioning is enabled in the player.  Otherwise you won’t be able to see captions. 

 

Additional Help 

1. You Tube: video on closed captions via Adobe Premier 

2. Adobe Help: Export closed captions on Adobe Premier 

3. Introductory tutorial to Adobe Premiere 

Adobe Premier Directions on Blurring Faces 
After you have uploaded your selected portion of video, follow steps I – VI below . . . 

I. Cutting 

A. Find the desired portion of video you want to blur. 

B. Use Razor (labeled “1” In screenshot on next page) to cut at the start and end of 

the section (labeled “2” and “3” in screenshot on next page). 

C. Go back to pointer tool. 

II. Timeline 

A. Hold alt while dragging the cut portion upwards to create a new section (“4”). 

III. Project Panel 

A. In Project Panel select ‘Effects’ top right (“5” in screenshot). 

B. Type in ‘Camera blur’ into the search bar below. 

C. Choose the highlighted Camera Blur. 

D. Drag to the Video overlay you created in the Timeline step. 

IV. Source Monitor 

A. Click on the circle or rectangle (“6” in screenshot). 

B. Click on the stopwatch icon in all Mask subcategories (“7” in screenshot). 

C. The Icons should turn blue. 

V. Timeline 

A. Drag the timeline marker (“9” in screenshot) to a tiny bit after the first cut, and let 

go of the marker.  You should see a blur appear in the video. 

B. Drag the blur so it covers up the face. 

C. Drag the timeline marker forwards. 

D. If the face is no longer covered by the blur, readjust the blur (step B) and continue 

dragging the timeline marker forwards.  

VI. Troubleshooting  

A. Make sure inverted check box is not selected (“8” in screenshot). 

B. In program monitor, make sure resolution is at ½  (“10” in screenshot). 

C. As your target student moves, you will need to readjust the blur (step D).  

https://www.youtube.com/watch?v=_5XnpOXDxfE&list=LLnOJFrv9COEAZ3SRbYZ4xrQ&index
https://helpx.adobe.com/premiere-pro/how-to/ame-export-closed-captions-cc.html
https://www.youtube.com/watch?v=wK3JTh2jOf8&list=WL&index=5
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Extra notes on Naming Your File 

When you name your movie, include the clip #, lesson #, date, subject, and format. Write 

something like this: 

 Clip1_L3_Sp1_QTstr_2011F 

Written out longhand, that would read “Clip 1, lesson 1, Spanish 1 class, in QuickTime 

streaming format, Fall 2011.” 

 

DO NOT use your name or the name of the school in your title. (Red ID is fine.) 

NOTE: If you want your own copy, save your file onto a data wand (USB key) or open 

your emailpress attachlook for your movie,click on itpress “ok.”  

 

Next Step -- UPLOADING TO TASKSTREAM: 
1. Go to TaskStream.com & look for your program (aka drf) 

2. Click on your program.  

3. Click on the task or area you are working on.  

4. Choose Add: Video (bottom left). 

5. Click Browse to find your file (on your computer). A screen will pop up. You usually 

can find movies by scrolling down to the movie icon. 

6. On the pop-up screen listing your files, find yours and click Open. 

7. On the main screen, click Add File 

8. Click Save & Return 

9. Double check that it worked by clicking on the movie and making sure it plays. (You 

may need to download a free copy of Quicktime if it is not already on your 

computer.) Note: If you can’t hear the sound, go to your computer’s control 

panel, select Sounds Speech and Audio devices, and make sure that it is not on 

mute & the sound is turned up. 

10. Follow the same procedure to attach your Commentary/Reflections as a Word 

Document. 

 
Trouble shooting: If you have trouble uploading your Quicktime file to 
TaskStream, it is probably too large.  There is a 500 MB limit for any 
single file and a 2000MB max for each account. If the file is the problem, 
go back into your video processing program and save a copy as 
streaming - medium quality or other lower quality format, then try 
again to upload.  
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If the account limit is the problem, contact your coordinator to see if you 
can get a free extension. Below are some tips for reducing the size of 
your video files. 

Reminder: Once you are finished with your complete teaching event or 
Project, be sure to go to the Scores/Results tab and submit it for 
evaluation.  If you are not yet finished, you can use the comments tab & 
click on “Request comments” to share it with a reviewer. 

What if I don’t have video editing software? 
If you don’t not have video editing software on your computer, here are two extra 
options. If you already have your clip selected & do not need to edit it down, 

you can download free compression and conversion software:  
 
For PC: http://www.any-video-converter.com/products/for_video_free/  

For MAC: https://itunes.apple.com/us/app/any-video-converter-
lite/id479472944  (Contact coordinator for directions, if needed.) 

http://www.any-video-converter.com/products/for_video_free/
https://itunes.apple.com/us/app/any-video-converter-lite/id479472944
https://itunes.apple.com/us/app/any-video-converter-lite/id479472944
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Tips for reducing the size of video files: 

 
1. Ensure that the sound is set to mono instead of stereo.  
2. Make sure the frame rate is set to no more than 15 frames per 
second. Using more frames per second will increase the size of your 
file. 
3. Increase the compression of your file to decrease file size. 
4. Reduce the size of the video: (320 x 240) is common on the web.  
This can be done automatically by using the export or share 
function in any editing program, clicking on Use or Options, then 
selecting a smaller format such as streaming –medium. 
5. Reduce the number of colors stored for each pixel (bit depth) 
 
If you have any additional questions or comments, please do not 
hesitate to contact help@taskstream.com or at 800-311-5656.  

 

Last Step: DELETING VIDEO FILES FROM THE COMPUTER 

Once finished converting your work & uploading it to your TaskStream 
program, check to make sure it plays. Then delete the files off of the 
computer & empty the computer trash (You may wish to keep a back up 
on your flash drive.) To delete files: 

 

1. Use the Find function to search for the title OR go to where movies 
are kept in the file directory. 

2. Delete the files (select/highlight file & press delete or drag to 
trash). 

3. Click on the trashcan icon on the bottom & chose “Empty Trash” 
from the scroll down menu. 

* Privacy Issue: If you are using a public computer such as those in the 
LARC lab, be extra sure to delete all of your files.  The waivers 
parents signed are for specific limited use only. Your video clips should 
never be open to access by the general public nor should they be used 
for job interview, etc. 
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Directions for Scanning 

Getting Started: Where to find a scanner 

Scanners are often built into printers these days.  If you have a printer, 
check if it also functions as a scanner. Otherwise, try one of the 
computer labs on campus: 

COMPUTER LABORATORY FACILITIES 
San Diego State offers several computer labs for your use. They all have 
computers, scanners, printers, plenty of programs, documentation, and 
people to help you with any questions. The hours change each semester; 
you can pick up a current listing of computer lab hours from EBA-134. 
The following are labs available free of charge for SDSU students: 

 Business Administration 110 BA113 - X-Terminals  
 Professional Studies and Fine Arts 126 - IBM PC's 
 Student Services 2659 - IBM PC's, Macs 

Physical Education 151 - IBM PCs, Macs 
 North Education 276 - Macs, Scanners, Video Systems and Laser 

Disks 
 The COE Office of Student Services (in EBA 259) also has 2 

scanners for student use. 
 Kinkos (various locations throughout San Diego) also has 

equipment for rent in their establishments - Macs, Scanner, IBM 
PCs  

 

 

Directions with Adobe Acrobat 7 

*Adobe Acrobat can be used with most any scanner. Launch Adobe 
Acrobat 7 by double-clicking the Acrobat shortcut on the desktop. 

Start with a clean, clear photocopy on 8.5 x 11-inch paper of the 
material you wish to scan. The photocopy should not have ragged edges 
or it will not feed properly through the scanner.  
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 Remove all dark center gutters from the photocopy. If there are 
any, please cover them with white paper and make a new 
photocopy before scanning. 

 Remove all unnecessary images from your article by cover then 
with a post-it note before photocopying. 

 Be certain that there are no dark borders on the sides of the pages 
that you are going to scan. You may correct this before scanning 
or crop the image once you have scanned it. 

 Make sure all pages are facing in the same direction to avoid 
having to rotate them individually at the end of the process. 

 Check the number of pages in the document. The automatic 
document feeder for the Fujitsu scanner can handle up to 50 
pages at a time. If your article has more than 50 pages, you'll need 
to scan in the first 50 pages, save the document, and then scan in 
the remainder, appending it to the end of the original document. 

 To prevent occasional paper jams, fan the paper before loading. 

 Lift the Balance Wire on the Automatic Document Feeder (ADF) 
and place the documents onto the paper chute face down, with the 
leading edge in the Auto Feeder entrance. Let the Balance Wire 
rest on top of the documents.  

 

 
Copyright Information  

Copyrighted material must have the source printed on each page. (Use 
APA format) 

 

http://www.wellesley.edu/Computing/Acrobat/E-Reserves/e-reserve-scanning-acrobat7.html#cropping
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Scanning the Image  

Make sure that the scanner is turned on and that no documents have 
been left on the flatbed of the scanner. 

From the File menu of Adobe Acrobat, select Create PDF and then 
From Scanner. 

 

A dialog box will appear 

 

In this window make the following selections from the pop-up menus: 
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Scanner: select the scanner you are using 
Scan: Front Sides 
Destination: Append to Current Document 

Click on the Scan button when all changes have been made.  

Place the documents face down on the document feeder tray or in the 
scanner. 

 

A dialog box will appear.  

 

Select the following settings: 

Image Mode: Line Art 
Resolution: 200x200 if you want a high quality image & plan to reduce 
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it later to upload on TaskStream OR between 70 & 96 dpi if you want a 
small file that is already reduced. 
Paper Size: Letter (8.5x11 in) 
Unit: Inches 
Scan Type: ADF 

 

Click on the Scan button.  

A progress box will appear as each page is scanned. 

Wait while the scanning takes place. The material will take longer to 
scan if there are more pages.  

When scanning is completed the Acrobat Scan window will appear. The 
scanner recognizes that there are no more pages on the feeder and 
wishes to know if the article is completely scanned or if you have more 
pages to scan. 

 

Select Done. 

Wait for the transfer to be completed. 

The document will appear in PDF format for viewing. 

 

Viewing the Scanned Pages 

To view the entire page at once, from the View menu, select Fit Page.  

Cropping Pages 
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Cropping does not reduce file size, but can eliminate black borders from 
documents or by removing excessive white margins have the text be a 
greater part of the actual page and print-out. 

Select the Crop Tool from the Advanced Editing toolbar 

.  

If you do not see the Advanced Editing toolbar, from the View menu, 
select Toolbars-Advanced Editing.  

 

Click and drag over the area of the page you want to keep.  

Press Enter twice to crop the page. 

 

Saving the Document 

From the File menu select Save As, so that you may give the file a new 
name. 

Be sure to save the file on the PC desktop so that you can find it easily. 

If you scanned at 200x200 dpi, you should save twice, once as a .pdf and 
then a second “save as” in jpeg format. For the second save, again 
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choose "File" from the menu, then "Save As" . Next to "Save as Type" at 
the bottom of the window, select "JPEG File Interchange Format". 

We recommend that the file name be no longer than 27 characters 
(excluding the ".jpeg" or “.pdf”) as it will be truncated by some versions 
of Acrobat Reader. You MUST include the .jpeg or .pdf extension! 

Click on the Save button. 

 

File Size 

Be sure to check the size of the file you plan to upload to TaskStream.  

From the File menu, choose Document Properties. 

The file size is noted at the bottom of the window. 

 

Typically, a PDF file scanned at 200 dpi is roughly 60 Kbytes per page.  
This is too large for TaskStream so make sure you have saved as a .jpeg 
or .gif with 72 dpi (dots per inch). 

Reducing File Size 

 Save as .jpeg or .gif (NOT pdf) with 72-95 dpi. When using a 
scanner, the scanning resolution determines the size of the 
scanned image. Use a resolution of 72 dots per inch (dpi) to get a 
life-size image when displayed on the screens of most computers. 
Since computer screens display between 72 and 95 pixels per 
inch, using a resolution higher than this will make your file size 
unnecessarily large.  
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 To create a smaller file, select "File" from the menu, then "Save 
As" . Next to "Save as Type" at the bottom of the window, select 
"JPEG File Interchange Format". 

 Scan each sheet separately unless you know you can fit size limit 
with all in one file. 

Merging scanned images into one file: 

 Use this link to find directions on merging PDF files on Mac using Preview: 

 

http://macintoshhowto.com/leopard/how-to-merge-pdf-files-with-preview-in-

leopard.html 

 

There are also several applications for Windows users (but none of them are built in): 

 

Web-based (Free) 

 http://merge.smallpdf.com   

 MergePDF. Merge up to 10 files. Max limit of 5MB/file. 

 PDF Hammer. Web-based PDF editor that supports merging of multiple files 

 Booklet Creater. Merges files to create a booklet. Rearranges pages to that you can 

print and fold to create a simple booklet. 

 BCL Premium PDF Merge Merge 2 PDF documents. Max 10MB/file. Limit of 20 

merges/day 

Desktop tools (free) 

 PDF Sam. Also known as "PDF Split & Merge". FOSS tool for splitting and merging 

PDFs. Windows & Mac. Console and GUI interfaces 

 Swift PDF. Combing multiple images into a single PDF. Does not merge PDFs, but 

does merge, JPG, GIF, etc. 

 pdftk. FOSS power tool. Command line only. Windows, Mac, Linux, FreeBSD. 

 

There are also a lot of commercial tools such as Adobe Acrobat (standard or professional, 

not the free preview).  

 

Saving a specific range of pages from a pdf. 
 
If you have Adobe Acrobat rather than just the reader, you can use the menu commands to save 
parts of pdf files. You'll have to initially save the entire PDF from the download. When you open 
the PDF in Adobe Acrobat, go to the "document" menu at the top, then "delete pages." Here, you 
should be able to delete all the pages you do not want. Save this file, either over the existing file 
name or as a new name. 
 
If you don’t have Adobe Acrobat, download the free web browser, Google Chrome. It has a built-
in PDF viewer enabled by default which allow you to print as PDF  
1. Open new tab in chrome browser  
2. Drag your pdf file to the tab  
3. Click print button / ctrl+p  

http://macintoshhowto.com/leopard/how-to-merge-pdf-files-with-preview-in-leopard.html
http://macintoshhowto.com/leopard/how-to-merge-pdf-files-with-preview-in-leopard.html
http://merge.smallpdf.com/
http://www.mergepdf.net/
http://www.nitropdf.com/free/hammer/index.htm
http://bookletcreator.com/
http://www.pdfonline.com/premium/Merge.aspx
http://www.pdfsam.org/
http://www.derring.com/swiftpdf/
http://www.accesspdf.com/pdftk/
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4. Choose save as pdf and choose your desired page number  
done! 
 

Source: https://answers.yahoo.com/question/index?qid=20080918093529AA2Sf2o  

 

How to Quit  

To quit out of Adobe Acrobat, choose File > Quit. 

 

 Directions taken from 
http://www.wellesley.edu/Computing/Acrobat/E-Reserves/e-
reserve-scanning-acrobat7.html (accessed 10/12/2008) & 
adapted by Tamara Collins-Parks. 

 Author: Susan Hand shand@wellesley.edu  Information Services. 
Date Created: March 20, 2000. Last Modified: September 6, 2006 

Q: How do I reduce the size of my scanned document if it's still too large 
to attach to my profile or application? 

 

A: 1) Always scan documents in black and white only, not in color or grey-

scale. 

 

2) If the document has watermarks, graphics, etc., photo copy the 

document at 50% darkness and then scan. 

 

3) Lower the resolution of your scanner from the default to either 100 or 75 

dpi “dots per inch”, and then rescan the file. 

 

4) It may also be necessary to make a copy of the document in black and 

white at a reduced size and then scan. 

 

If you are still unable to reduce the size of your documents, your local 

Kinko's or business supply should be able to assist you. You will need to 

take a hard copy of your documents with you. They will need to make sure 

each document does not exceed 1MB (1024 KB) and is scanned in as either 

a .PDF or .JPG file. They will charge a fee for their services. 

Source: help page on ED-Join http://www.edjoin.org/help.aspx.  
Accessed 4/27/2012 
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